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About this Installation and Setup Guide
About this Installation and Setup Guide

Symbols Used

Terminology
Generally, the Thomson ST585(v6)(i) will be referred to as Thomson Gateway in this Installation and Setup 
Guide.

Typographical Conventions
Following typographical convention is used throughout this manual:

> Sample text indicates a hyperlink.

Example: For more information, visit us at www.thomson-broadband.com.

> Sample text indicates an important content-related word.

Example: To enter the network, you must authenticate yourself.

> Sample text indicates a GUI element (commands on menus and buttons, dialog box elements, file 
names, paths and folders).

Example: On the File menu, click Open to open a file.

Documentation and software updates
Thomson continuously develops new solutions, but is also committed to improving its existing products.

For suggestions regarding this document, please contact documentation.speedtouch@thomson.net.

For more information on Thomson's latest technological innovations, documents and software releases, visit 
us at http://www.thomson-broadband.com.

i A note provides additional information about a topic.

! A caution warns you about potential problems or specific precautions that need to be taken.
E-DOC-CTC-20060911-0041- v1.0
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Chapter 1
Introducing the Thomson Gateway
1 Introducing the Thomson Gateway

Introduction
In a minute you will be able to access the Internet using your Thomson Gateway.

This Installation and Setup Guide will show you how to set up your Thomson Gateway and how to connect a 
computer or a Local Area Network (LAN) to the Internet.

Identifying your Thomson Gateway
The label on the bottom of your Thomson Gateway informs you about the Thomson Gateway’s:

> Product name

> Model number

> Serial number

> Power requirements

DSL variants
The Thomson Gateway comes in two ADSL variants:

> POTS: The Thomson ST585(v6) connects to an analogue Plain Old Telephone Service (POTS) line.

> ISDN: The Thomson ST585(v6)iconnects to an Integrated Service Digital Network (ISDN) line, enabling 
residences with an ISDN line to use the ADSL service.

You can easily identify your variant by checking the product name printed on the label on the bottom of your 
Thomson Gateway.

! Do not remove or cover the label.

The ... variant supports ...

POTS ADSL

ADSL2

ADSL2+

RE-ADSL

ISDN ADSL

ADSL2

ADSL2+

! Only use the Thomson Gateway variant which is appropriate for the DSL service provided to your 
premises.
E-DOC-CTC-20060911-0041- v1.0
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Chapter 2
Basic Installation
2 Basic Installation

Before you begin
Make sure you read the safety instructions and regulatory notices first. You can find the safety instructions on 
the Setup CD (see “2.2 Installing your Thomson Gateway” on page 7). They may also be provided as a 
printed booklet.

ADSL service
The ADSL service must be up and running on your telephone line.

If both conventional telephone and ADSL service are simultaneously available from the same copper pair, 
you will need a central splitter or distributed filters for decoupling ADSL and telephone signals.

Computer requirements
> To connect computer(s) via Ethernet, make sure the computer(s) are equipped with an Ethernet network 

interface card (NIC).

> For wireless networking, you will need a wireless 802.11 b/g compatible client adapter for each computer 
you intend to connect wirelessly.

Wireless client adapters
You can use one of the following wireless client adapters:

> Thomson ST110g CardBus

> Thomson ST121g USB adapter

> Thomson ST122g USB adapter

> Any other Wi-Fi certified WLAN client

Internet connection details
You need the following connection details from your Internet Service Provider (ISP): 

> Your ISP’s method for connecting to the Internet (for example PPPoE)

> The VPI/VCI (for example 8/35)

> Your user name and password to connect to the Internet

You must have received this information when you subscribed to DSL at your Internet Service Provider (ISP). 
You will be prompted for this information at a given step in the installation procedure.

! Public telephone lines carry voltages that can cause electric shock. Only try to set up splitter/filters 
that have been designed to be installed by unqualified personnel. For further assistance, contact 
your Internet Service Provider.
E-DOC-CTC-20060911-0041- v1.0
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Chapter 2
Basic Installation
2.1 Mounting your Thomson Gateway

Setup possibilities
You can mount the Thomson Gateway on a wall or simply place it on a desk.

Wall mount
Proceed as follows to mount the Thomson Gateway on a wall or other vertical surface:

1 Drill two holes in the wall or other vertical surface where you want to place the Thomson Gateway.

2 Fasten two screws in the wall holes. The screws should protrude five millimetres from the surface of the 
wall.

3 Attach your Thomson Gateway on the wall using the two mounting slots on the bottom.

i If you install the Thomson Gateway onto plasterboard, use dowels to secure the screws. 
Otherwise the strain of the cables connected to the Thomson Gateway rear panel connectors 
could pull the Thomson Gateway from the wall.

MODEM ACCESS CODE: 0123456789

MAC: AAABCCCDDEEE

THOMSON TELECOM

*ACCESS CODE 0123456789*

*MACADDRESS AAABCCCDDEEE*
SSID:SoeedTouchVVVVVV

WEP (hex):1234ABCDEF

WPA PSK: 1234ABCDEF

TCM: 12345670

SpeedTouch ZZZ
DSLBSFFFFF RQQI

S/N:CPYYWWPPXXX (CC)

*DSLBSFFFFF RQQI*DSLBSFFFFF RQQI

*MACADDRESS AABCCCDDEEE*

RATED INPUT: 18V~
1000mA

!
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6



Chapter 2
Basic Installation
2.2 Installing your Thomson Gateway

Internet connectivity setup
There are different ways to set up your Thomson Gateway. The best way depends on your operating system.

If you use the following operating 

system

the recommended way to set up your Thomson 

Gateway is

Microsoft Windows (98 SE, Millennium, 
2000 or XP)

the Home Install Wizard, as described in “2.2.1 Guided 
Installation” on page 8.

Mac OS X, provided you use a wired 
connection to your Thomson Gateway

Any operating system (provided you 
have IP connectivity)

the Easy Setup, as described in “2.2.2 Manual Installation” on 
page 16.

Mac OS X, wirelessly connected to your 
Thomson Gateway and provided you 
have IP connectivity
E-DOC-CTC-20060911-0041- v1.0
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Chapter 2
Basic Installation
2.2.1 Guided Installation

Introduction
On the CD, a Quick-Install Wizard is provided that will guide you through the first installation and setup of 
your Thomson Gateway.

The Quick-Install Wizard will:

> Provide important safety and regulatory information.

> Show you how to make the necessary connections to your Thomson Gateway.

> Show you how to turn on your device.

> Prepare you to smoothly run the Thomson Gateway Home Install Wizard.

The subsequent Home Install Wizard will then prepare your Thomson Gateway and your local computer(s) to 
connect to the Internet.

The Home Install Wizard will:

> Guide you through connecting your computer(s) to your Thomson Gateway.

> Prepare the Thomson Gateway to connect to the Internet.

Connecting the cables: wait!
Do not plug in any cables until you are prompted to do so by the Quick-Install Wizard and/or the Home Install 
Wizard.

Starting the CD for the first time 
To start the Thomson Gateway Setup:

1 Insert the Setup CD into your computer's CD-ROM or DVD-ROM drive. 

Microsoft Windows: The CD should autostart.

Mac OS X: Double-click Menu in the window with the content of the CD.

2 Select the language of your choice and click OK.

3 The procedure continues with the Quick-Install Wizard.

Proceed with “ Quick-Install Wizard” on page 8.

Quick-Install Wizard
The Quick-Install Wizard guides you through the first setup of your Thomson Gateway.

1 On the Welcome page, click Next to continue. 

! You need administrative rights to run the applications on the Setup CD on a Microsoft Windows 
2000 or XP operating system, or Mac OS X computer.

! If not, see ”The Thomson Gateway CD does not start automatically” on page 35.

! If you ran the CD on this computer before, the Quick-Install Wizard is not shown; the CD menu 
appears instead (see “2.3 The Setup CD” on page 18 for more information).
E-DOC-CTC-20060911-0041- v1.0
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Chapter 2
Basic Installation
2 Select your Thomson Gateway from the list of supported devices and click Next.

The Thomson Gateway Safety Instructions and Regulatory Notices are displayed. 

3 Scroll down and read all the instructions carefully, select I have read and I fully understand the Safety 

Instructions and Regulatory Information to confirm your reading, and then click Next.

4 Subsequent screens guide you through the preliminary hardware setup of your Thomson Gateway.

Follow all the instructions carefully and click Next each time your are ready to proceed.

5 Click Set up my THOMSON ST to continue.

6 The procedure continues with the Home Install Wizard.
Proceed with “ Home Install Wizard” on page 10.

i A product picture helps you to easily identify your Thomson Gateway. If you are not sure 
what device you have, check the label on the bottom of your Thomson Gateway.

! Your Thomson Gateway is designed and tested to meet the latest safety standards. However, to 
ensure safe use of this product, it is important that you carefully read and comply with the 
Safety Instructions and Regulatory Notices shown and/or available in the Safety and 
Regulatory booklet before you install the Thomson Gateway.
E-DOC-CTC-20060911-0041- v1.0
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Chapter 2
Basic Installation
Home Install Wizard
The Home Install Wizard guides you through your local network connections and prepares the Thomson 
Gateway to connect to the Internet. Proceed as follows:

1 On the Welcome page, click Next to continue.

The Software License Agreement window appears.

2 You must accept before continuing. Click Yes to accept.

The Home Install Wizard checks your system and invites you to connect the Thomson Gateway to your 
computer.

! If you accepted the Software License Agreement in a previous configuration setup, this window 
will not be shown.
E-DOC-CTC-20060911-0041- v1.0
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Chapter 2
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3 Make one of the following connections:

Connect the yellow RJ-45 Ethernet cable to the yellow (indicated) Ethernet port on your Thomson 
Gateway and the other end to the computer’s Ethernet port.

For wireless networking, plug a wireless card or adapter into your computer.

4 Once the hardware is installed and connected to the Thomson Gateway, the procedure continues with 
configuring your Internet connection.

Proceed with “ Configuring the Internet connection” on page 12.

i In case of problems or for advanced information, see “2.5.1 Wireless Setup” on page 22.

i If the wizard does not detect a connection, an error message will be displayed. Refer to “ The 
wizard does not detect a connection” on page 35.
E-DOC-CTC-20060911-0041- v1.0
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Basic Installation
Configuring the Internet connection
Proceed as follows:

1 If prompted, enter the User name and Password for your Thomson Gateway security settings and click 
OK.

2 Select the appropriate Region, Provider and Service for your Internet connection as specified by your 
Internet Service Provider and click Next.

3 Your connection to the Internet connectivity is set up:

Select the VPI/VCI - and, if required, the Connection Type - as specified by your Internet Service 
Provider and click Next.

Enter the User Name and Password for your Internet account settings as specified by your Internet 
Service Provider and click Next.

4 The procedure continues with some additional configurations.

Proceed with “ Configuring the Thomson Gateway (and your computer)” on page 13.

i The factory default user is ‘Administrator’ and its password is blank. It is advisable to specify 
another user name and password during the configuration procedure to protect your Thomson 
Gateway from security violation. See “2.6 Basic Security” on page 24 for more information.
E-DOC-CTC-20060911-0041- v1.0
12



Chapter 2
Basic Installation
Configuring the Thomson Gateway (and your computer)
Proceed as follows:

1 Depending on the selected service profile and your ISP’s requirements, you may have to fill in some 
additional settings during the Home Install Wizard, like Dynamic DNS Service, Time Configuration or 
other.
Enter the information provided by your ISP and click Next whenever requested.

2 To protect the wireless connections to your Thomson ST, move the slide control to the desired security 
mode.

The following security modes to secure traffic between the Thomson Gateway and connected wireless 
stations are available:

Low, which implies in fact that no security measures are taken at all.

Medium, implying that traffic is encrypted by means of a static encryption key (WEP).

High, providing the highest security standard available (WPA) for encrypting all wireless traffic.

i For an overview of all Thomson Gateway wireless security features, see “ Securing your 
wireless network” on page 24.
E-DOC-CTC-20060911-0041- v1.0
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Chapter 2
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3 Provide a user name and password to protect your Thomson Gateway from unauthorised access. Each 
time a user wants to access a Thomson Gateway management interface, the user will be prompted to 
provide this user name and password before access is granted.

Click Next to continue.

4 The procedure continues with the final steps of configuring your Thomson Gateway and your computer.

Proceed with “ Finishing the Home Install Wizard” on page 15.
E-DOC-CTC-20060911-0041- v1.0
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Finishing the Home Install Wizard
The Home Install Wizard will configure the Thomson Gateway and your computer according to the service 
profile. Proceed as follows:

1 You can follow the configuration progress in following window:

2 Click Finish to close the wizard.

The following steps will happen automatically:

After some seconds, the Internet  LED on your Thomson Gateway will be lit green to indicate Internet 
connectivity. If not, refer to “4.2 LED Diagnostics” on page 31. If needed, you can test your Internet 
connection as described in “ Testing your Internet Connection” on page 33.

The CD Menu is displayed. See “2.3 The Setup CD” on page 18 for more information.

You are redirected to the embedded Thomson Gateway pages automatically (unless you cleared the 
http://dsldevice.lan check box in the last window of the Home Install Wizard). These pages allow you 
to configure the Thomson Gateway firewall, Thomson Gateway settings, your wireless access point 
settings, and so on. See the User’s Guide for more information.

More on IP settings 
In most cases, the computer’s networking interface used during the Home Install Wizard procedure will be 
configured for obtaining its IP configuration dynamically. This is the most convenient configuration and 
should not be changed.

i For fixed or advanced IP configurations, please follow the instructions of your ISP.
E-DOC-CTC-20060911-0041- v1.0
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2.2.2 Manual Installation

Web-based Easy Setup
With the help of the Easy Setup, your Internet connection is set up in a few clicks. 

The Easy Setup is Operating System independent.

Preconditions
Make sure that:

> Your Thomson Gateway is correctly set up and turned on.

> Your computer is connected to the Thomson Gateway. In case of a wireless connection, a wireless client 
adapter has to be installed on your computer and correctly configured to connect to your Thomson 
Gateway.

> Your host computer is configured as DHCP client or with a valid fixed IP address. For more information, 
refer to the Help of your browser.

> Your Web browser is not using a proxy server. For more information, see “ Disable proxy server” on 
page 40.

HTTP intercept
Proceed as follows:

1 Open a Web browser. Browse to an arbitrary Web site, for instance http://www.thomson-broadband.com. 
As long as no Internet connection has been set up, you will be automatically redirected to the Thomson 
Gateway Welcome page. 

2 Click Set up my SpeedTouch to start the Easy Setup wizard. 

3 Proceed with “ Using Easy Setup” on page 17.

i See “ Wiring” on page 20 for a comprehensive overview of all Thomson Gateway connections.

i In case of problems, you can give the host computer a fixed IP address in the same subnet as 
your Thomson Gateway (If the Thomson Gateway is in its default settings, that is an address 
between 192.168.1.1 and 192.168.1.253). In case you use fixed IP addresses, the Thomson 
Gateway has to be configured as DNS server.

i If you are not redirected automatically, go to “ Starting the Easy Setup wizard” on page 17.
E-DOC-CTC-20060911-0041- v1.0
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Starting the Easy Setup wizard
You can also start the Easy Setup wizard from within the embedded Web pages. Proceed as follows:

1 Browse to the Thomson Gateway pages on http://dsldevice.lan or on its IP address, 192.168.1.254 by 
default).

2 In the menu, click SpeedTouch.

3 In the Pick a task list, click Set Up.

Using Easy Setup
In the Easy Setup wizard:

1 Click Next to proceed. If for some reason you want to abort the wizard, click Cancel.

2 Choose the Service provided by your ISP (Router or Bridge) and click Next.

3 Select the appropriate VPI/VCI - and, if required, the Connection Type (PPPoE or PPPoA) - provided by 
your ISP, and then click Next.

4 For a Routed service, fill in the Internet Account settings (PPP user name and password) provided by your 
ISP, and then click Next.

5 Fill in a Security user name and Password for your Thomson Gateway.

6 In the next window you can review your settings, before starting the configuration of your Thomson 
Gateway. If something is missing or incorrect, click Back. To confirm your settings, click Start.

7 Wait until the configuration is finished, and then click Finish.

i The factory default user is ‘Administrator’ and its password is blank. It is advisable to specify 
another Administrator user name and password to protect your Thomson Gateway from 
security violation, as described in “2.6 Basic Security” on page 24. 
E-DOC-CTC-20060911-0041- v1.0
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2.3 The Setup CD

Setup CD
Your Thomson Gateway comes with a Setup CD. If you insert the Setup CD into a Microsoft Windows PC or 
Mac OS X computer, an intuitive CD Menu guides you through the features and contents of the Setup CD and 
allows you to easily browse for user documentation, Thomson Gateway system software, service templates, 
etc.

CD menu
The CD menu appears automatically each time you insert the CD, or after running the Quick-Install Wizard 
and subsequent Home Install Wizard:

Select:

> Run Quick Installation to start the Quick-Install Wizard and Home Install Wizard.

> Maintenance to:

Reconfigure your Thomson Gateway via the Home Install Wizard.

Check for software upgrades.

> Documentation and Help to:

Consult user documentation for your Thomson Gateway.

Consult user documentation for Thomson networking products.

See more information on Thomson products and solutions.

If you connect to the Internet, the document list will automatically be updated with the latest 
documentation.

i If you have problems viewing the documentation, see “ I cannot view the Thomson Gateway 
documentation” on page 36.
E-DOC-CTC-20060911-0041- v1.0
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> Visit Thomson Broadband to visit the online support sections on www.thomson-broadband.com.

> View CD Contents to open a new window to view the Setup CD contents.
E-DOC-CTC-20060911-0041- v1.0
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2.4 Thomson Gateway Connection Essentials

Wiring
The image below shows all possible types of connection to the Thomson Gateway.

Making connections
In most cases, the Quick-Install Wizard and Home Install Wizard will guide you through the process of making 
all the required connections to your Thomson Gateway.

If you want to make the required connections yourself, see “2.5 Connections Overview and Powering” on 
page 21 for more information.

Ethernet

1 432

DSLReset

1

2

4

3

ON/OFF

i It is recommended to wait to make any of these connections until the wizard prompts you to do so. 
See “2.2 Installing your Thomson Gateway” on page 7 for more information.
E-DOC-CTC-20060911-0041- v1.0
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2.5 Connections Overview and Powering

Introduction
If you want to make the required connections yourself without using the guided installation procedure as 
recommended, you must:

> Read the safety instructions and regulatory notices first.

> Follow the order as indicated below.

DSL connection
Use the grey DSL cable to connect the Thomson Gateway DSL port to your telephone wall outlet or 
distributed filter.

Powering the Thomson Gateway
Plug the coaxial jack of the electric power supply adapter into the Thomson Gateway power inlet port and the 
other end into the wall outlet.

To turn on the Thomson Gateway, press the power button on the Thomson Gateway rear panel.

During the start-up procedure, the power LED on the front panel is lit red for some seconds. As soon as the 
power LED is solidly lit green, your Thomson Gateway is ready for service. After another couple of seconds, 
also the DSL LED will light green.

If these LEDs do not light, please refer to ”Checking the LEDs” on page 31. A comprehensive LED overview 
can be found in the User’s Guide.

Use the same button to turn off your Thomson Gateway.

Network connections
Your Thomson Gateway allows you to connect your computer(s) via: 

> Ethernet

> Wireless networking

i You can find the safety instructions on the Setup CD (see “2.2 Installing your Thomson 
Gateway” on page 7). They may also be provided as a printed booklet.

i The Thomson Gateway electrical power requirements are indicated on the label on the bottom side 
of your Thomson Gateway. In case you need to use another power supply than the one provided, 
make sure that the spare supply complies with the Thomson Gateway power requirements.
E-DOC-CTC-20060911-0041- v1.0
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2.5.1 Wireless Setup

Wireless client adapters
If you want a wireless connection to your Wi-Fi certified Thomson Gateway, you need a wireless 802.11 b/g 
compatible client adapter.

You can use one of the following wireless client adapters:

> Thomson ST110g CardBus

> Thomson ST121g USB adapter

> Thomson ST122g USB adapter

> Any other Wi-Fi certified WLAN client

> A built-in Wi-Fi certified WLAN adapter, if present in you computer

i To install hardware on a Microsoft Windows 2000 or a Microsoft Windows XP operating system, 
you need administrative rights on your computer.
E-DOC-CTC-20060911-0041- v1.0
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Installing your wireless client adapter
Proceed as follows when the Home Install Wizard prompts you to plug in the wireless client adapter:

1 Plug in the wireless client adapter. The hardware is being installed.

2 Enter your Thomson Gateway’s serial number and click Next.

A progress window appears, showing the setup of the wireless connection to your Thomson Gateway.

3 Continue with ”Configuring the Internet connection” on page 12.
E-DOC-CTC-20060911-0041- v1.0
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2.6 Basic Security

Default user name and password
The Thomson Gateway comes with a default user. Its user name is ‘Administrator’ and the default password 
is blank.

Changing your password
For security reasons, it is recommended to set a password to access the Thomson Gateway. Proceed as 
follows:

1 Go to the Thomson Gateway home page (http://dsldevice.lan or 192.168.1.254).

2 In the left pane, choose Toolbox > User Management. 

3 In the Pick a task list, click Change my password.

4 Enter a new password and confirm.  

Default wireless security settings
Also for wireless connections to your Thomson Gateway, by default there are no security settings, so the 
Thomson Gateway is initially accessible to all wireless devices:

> The Network Name (SSID) is broadcast.

> The security level is initially set to Low (that is: no encryption is used).

> The Access Control List (ACL) is open and empty. New stations are automatically allowed to access the 
Thomson Gateway.

It is recommended to change these Thomson Gateway wireless access point settings either automatically via 
the Thomson Gateway Home Install Wizard, either manually as described in the Thomson Gateway User’s 
Guide.

Securing your wireless network
To secure your wireless network, you can:

> Allow or deny access based on the MAC address of the wireless client(s). Known MAC addresses are kept 
in the Access Control List (ACL). If the Thomson Gateway is configured to allow new stations via 
registration, unknown computers will have to register before they can connect.

> Turn off the broadcast of the wireless Network Name (SSID). New wireless clients that are scanning for 
available networks will not see your network appear in their list.

i Do not forget this logon information or you will be forced to reset the Thomson Gateway back 
to its default configuration.

i For the ACL you have the following options: 

> Allowed (automatically): All new stations can access the Thomson Gateway.

> Allowed (via registration): Only allowed stations in the ACL have access. You can add new 
stations via the Association / Registration button.

> Not allowed: Only allowed stations in the ACL have access.
E-DOC-CTC-20060911-0041- v1.0
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> Encrypt the data that will be sent over the wireless network. You can choose different encryption methods 
or levels of security:

High: Wi-Fi Protected Access Pre-Shared Key (WPA-PSK) encryption, the highest form of security 
available. This can only be used if your wireless client and client manager support it.

Medium: Wired-Equivalent Privacy (WEP) encryption.

Low: no encryption, no security.

i For more information, see the Thomson Gateway User’s Guide.
E-DOC-CTC-20060911-0041- v1.0
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3 Web-Based User Interface

Embedded pages
The Thomson Gateway comes with embedded web pages, providing an interface to the software installed on 
the device. It allows Easy Setup and management of the Thomson Gateway via your web browser from any 
computer connected to the Thomson Gateway.

Access
Proceed as follows to access the pages:

1 Open your Web browser.

2 In the address bar, type http://dsldevice.lan or your Thomson Gateway’s IP address (the default IP address 
is 192.168.1.254) and press ENTER. 

3 Enter your Thomson Gateway security user name and password. 

4 The Thomson Gateway’s home page will be displayed in your browser. From here - depending on the 
rights of your user account - you have access to the other pages.

Tasks
Among others, you can:

> View the Thomson Gateway’s current settings and status.

> Configure the Thomson Gateway to connect to your Service Provider with the settings provided.

> Set the Thomson Gateway’s firewall to work with specific applications.

> Set up security features.

> Enable remote management access.

> Back up your configuration settings.

> Reset the Thomson Gateway’s default settings.

Using the Web pages
When making changes to the Thomson Gateway configuration via the Web pages, the configuration is stored 
automatically whenever you click Apply. 

For more information on the embedded pages, refer to the Help in the upper right corner of the notification 
and navigation area or refer to the Thomson Gateway User’s Guide.

i The default user name is ‘Administrator’ and the default password is 
blank.
E-DOC-CTC-20060911-0041- v1.0
27

http://dsldevice.lan
http://192.168.1.254


Chapter 3
Web-Based User Interface
Site Map
The following Site Map gives you an overview of the main pages:

Toolbox

Firewall

Home Network

SpeedTouch

Broadband Connection

Information
Configuration

Event Logs

DSL Connection
Internet Services

Remote Assistance

Parental Control

Intrusion Detection
Dynamic DNS

User Management

Game & Application Sharing

Devices
Interfaces
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4 Troubleshooting

What to check
The first things to check if you cannot access the Internet, are:

> Power

> Hardware connections

> LEDs

Configuration problems
If your Thomson Gateway is unreachable due to misconfiguration, you might consider a hardware reset to 
factory defaults as described in “4.7 Reset to Factory Defaults” on page 41.

If the suggestions in this chapter do not resolve the Internet connection problem, please contact your Internet 
Service Provider.

! However, note that resetting the Thomson Gateway to its factory settings will revoke all the 
changes you made to the configuration.
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4.1 Checking the Hardware

Check the wiring
Plug in properly all the cables you need. Make sure that the cables between your Thomson Gateway, 
computers and telephone socket are plugged in firmly. Loose connections can affect your Internet 
connection.

Damaged cables can interfere with your Internet connection. Check for damage along the cables and loose 
connections at the end of the cable. Replace any damaged cables.

Test the telephone line
To eliminate the possibility of a fault with the telephone line itself, check for a dialling tone by using a 
telephone connected to the telephone master socket. 

If you are using ADSL, check whether a splitter has been installed or that micro-filters have been correctly 
fitted. 

Contact your telephone company if there is no dialling tone.

Restart your computer
Loss of Internet or network connectivity may be caused by the computer. Restarting your computer may 
solve the problem.

Power-cycle the Thomson Gateway
To restart your Thomson Gateway, simply turn it off. Wait five seconds and turn it back on.
E-DOC-CTC-20060911-0041- v1.0
30



Chapter 4
Troubleshooting
4.2 LED Diagnostics

Checking the LEDs
After establishing a connection with the Internet, at least the following LEDs should solidly light green: 
Power, DSL, Internet.

LED status Possible solutions

No LEDs are lit The Thomson Gateway is not turned on, or turned off.

> Make sure the Thomson Gateway is plugged into an electrical outlet.

> Make sure you are using the correct power supply for your Thomson 
Gateway. The Thomson Gateway electrical power requirements are 
indicated on the label on the bottom of your Thomson Gateway.

> Make sure the Thomson Gateway is turned on.

> Unplug the Thomson Gateway, restart your computer and then plug the 
Thomson Gateway back in.

Power LED is lit red or 
flashing amber

The Thomson Gateway is malfunctioning or not able to start up.

> Fully unplug the Thomson Gateway from your computer and disconnect 
it from its power supply. Wait five seconds, connect the Thomson 
Gateway again and turn it back on.

DSL LED is flashing green 
or no DSL LED

Your DSL service is unable to synchronise.

> Make sure the Thomson Gateway is plugged into the DSL-enabled phone 
line.

> Make sure micro-filters are correctly fitted (if not, it is very likely that your 
regular telephone service is not working properly).

> Make sure you have the correct Thomson Gateway variant (ISDN or 
POTS) according the DSL/phone service provided to your premises.

> If you have previously had a working connection, call your ISP to check 
for service outages.

No Ethernet LED
No Ethernet port’s Link 
Integrity/Activity LED

No Ethernet connectivity: 

> Make sure the Ethernet cable(s) are firmly connected to the 10/100Base-T 
port.

> Make sure you are using the correct cable type for your Ethernet 
equipment.

> Make sure the Ethernet NIC driver is correctly installed and enabled on 
your computer. Power safe options for the Ethernet NIC should preferably 
be disabled.
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You can find a comprehensive LED overview in the User’s Guide.

WLAN LED is flashing or 
not lit

> The WLAN LED flashes if there is wireless LAN activity and can have 
different colours:

Green: The Thomson Gateway wireless access point is operating in 
the highest security mode (WPA). Make sure to use the same WPA 
encryption on the WLAN client.

Amber: The Thomson Gateway wireless access point is operating in 
medium security mode (WEP). Make sure to use the same WEP 
encryption on the WLAN client.

Red: The Thomson Gateway wireless access point uses no security.

> The WLAN LED is not lit if the Thomson Gateway wireless access point is 
disabled. For wireless networking, make sure the WLAN is enabled on the 
Thomson Gateway. Proceed as follows:

1 Go to the Thomson Gateway Web pages.

2 In the menu select Home  Network > Interfaces.

3 Click WLAN.

4 Click Configure.

5 Select Interface Enabled.

- OR - 

1 Press and hold the Association / Registration button until the WLAN 
LED is lit (green, amber or red).

2 The WLAN LED is toggling between red and green: If new stations are 
only allowed via registration and if you pressed the Association / 
Registration button, the ACL will be unlocked for 30 seconds during 
which you can connect new wireless clients.

Red Internet LED or No 
Internet LED

> There was an authentication failure. This will usually present itself as an 
error message regarding an incorrect password.

Check whether your user name is correct. For ADSL connections, the 
user name is normally in the form of username@ISP.

Check whether your password is correctly entered. The password is 
case sensitive.

If you continue to get password failures, contact your ISP.

> The wrong service profile was selected. Restart the setup of your 
Thomson Gateway, and make sure to select the correct service profile.

LED status Possible solutions
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4.3 Web Diagnostics

Testing your Internet Connection
After setting up the Internet connection, there is an easy way to check whether your configuration is fine. 
Proceed as follows:

1 Go to the Thomson Gateway home page (http://dsldevice.lan or 192.168.1.254). 

2 In the menu, click SpeedTouch. 

3 In the Pick a task list, click Check connectivity to the Internet.

4 In the Internet Service to Check box, select the Internet service you want to check.

5 Click Check Connectivity.

If the test is successful, you will see a list of green check marks as shown in the example below:

Otherwise a red cross will help you to diagnose the problem:

Test result Explanation

Your DSL line is not synchronised.

> Check whether your telephone line is correctly connected to 
your Thomson Gateway.

> Check the DSL LED, as described in “ Checking the LEDs” on 
page 31.

No ATM activity detected on your DSL line.
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No Ethernet activity.

If you are connected through a protocol other than PPPoE, this 
check is not applicable as the result will always be ‘No Ethernet 
activity’. 

> Authentication failed: check your user name and password. 
The user name is in most cases in the form of 
username@ISP.

> Your connection is disconnected.

> Could not bring up link.

No IP No IP address or no DNS server has been configured. During IP 
address negotiation, there was an IPCP error or a DHCP error. 

No Internet This test sends 1 ping to each address of a configured list of IP 
addresses. The test succeeds if all addresses can be reached. If 
your primary and secondary DNS server are part of the list, 
reaching one of both is enough.

No DNS The DNS service provided by your ISP may have a problem. 

Test result Explanation
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4.4 Thomson Gateway Setup CD Troubleshooting

The Thomson Gateway CD does not start automatically
Proceed as follows:

> In Microsoft Windows:

1 In the Windows task bar, click the Start button. 

2 Select Run.

3 In the Open field, enter the following path: D:\Setup.exe, where D stands for the drive letter of your 
CD-ROM drive.

> In Mac OS X: 

1 On your desktop, double-click the CD icon.

2 Double-click Menu.

The wizard does not detect a connection
If the Home Install Wizard does not detect a connection to your Thomson Gateway, an error window appears. 

If this is the case, check whether:

> The Thomson Gateway is turned on and fully initialised.

> Your computer has a valid IP address, that is any address but 0.0.0.0. 

In Microsoft Windows:

1 In the taskbar, click the Start button.

2 Select Run.

3 In the Open field, type cmd.

4 Click OK.

A black window will appear with a flashing cursor.
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5 Type ipconfig /all and press ENTER.

Your IP address is displayed. 

In Mac OS X:

1 Go to Dock > System Preferences.

2 Click Network.

3 Click the TCP/IP tab.

Your IP address is displayed.

> No dedicated firewall device or router is placed between your computer and the Thomson Gateway.

> No personal network security software (for example firewall software) is running on your computer.

> Your computer is correctly connected to the Thomson Gateway, or the WLAN client is correctly 
associated with the Thomson Gateway.

1 In the Windows XP notification area, click the Wireless Network Connection icon  or the Thomson 
Gateway Client Manager icon .

2 Check whether the displayed network has your Thomson Gateway network name (SSID).

To repeat the search for your Thomson Gateway, click Back or restart the wizard. As soon as the wizard finds 
your Thomson Gateway, you can continue with “ Configuring the Thomson Gateway (and your computer)” 
on page 13.

The Thomson Gateway is not responding
If the completion window does not appear after running the Thomson Gateway Home Install Wizard, this 
means that the Thomson Gateway is not responding or not accessible anymore.

There are two possibilities:

> This might be due to the reconfiguration of the Thomson Gateway’s IP settings or wireless access point 
settings. In this case, the last window of the Home Install Wizard will not be shown. Your Thomson 
Gateway is correctly set up though and you will be able to surf the Internet.

> If you did not reconfigure the Thomson Gateway’s IP settings or wireless access point settings, restart the 
Home Install Wizard.

If the problem persists, refer to the Service Provider’s instructions for more information.

I cannot view the Thomson Gateway documentation 
To be able to view the Thomson Gateway documentation pages on the Setup CD, JavaScript must be enabled 
in your Web browser. For more information, refer to the Help of your Web browser.

To allow active content on a Microsoft Windows XP system, see “ I get a warning about active content in 
Internet Explorer” on page 37.

i In Microsoft Windows 98 or Microsoft Windows Millennium, type winipcfg and then 
press ENTER.

i If you are not connected, this icon will have a red cross: 

i If the setup fails over a wireless connection, try to set up your Thomson Gateway using a wired 
connection.
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I get a warning about active content in Internet Explorer 
When opening documentation pages from the Setup CD, a warning might be displayed. This may be the case 
when the pages are opened in Internet Explorer and you are using Microsoft Windows XP with Service Pack 
2.

Proceed as follows to view the documentation:

1 In Internet Explorer, the following message will appear in the Information Bar:

2 Click the Information Bar (with the warning).

3 Select Allow Blocked Content.

A security warning is displayed:

4 Click Yes.

You can now view or print the Thomson Gateway documentation pages.

i This warning will be displayed every time you consult the documentation. If you do not want this 
message to be shown in the future, you must allow CDs to run active content on your computer:

1 In the Internet Explorer menu, select Tools > Internet Options.

2 Click the Advanced tab.

3 Under Security, select Allow active content from CDs to run on My Computer.
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4.5 Windows Zero Configuration

About Windows Zero Configuration (WZC)
The Windows Zero Configuration (WZC) service allows you to automatically configure your wireless 
connections. WZC is a part of Windows XP SP 2 and above. When you install a Thomson Gateway wireless 
networking product, it will automatically use WZC whenever possible. If not, a dedicated client utility is 
installed. 

How to Open the WZC Service
By default, WZC should be active. To open the service click Start > Connect to > Wireless Network 

Connection.

This opens the Wireless Network Connection window : 

The installation of your wireless network adapter may have disabled WZC. In this case,the following will 
appear: 

You should use the utility corresponding with your wireless network adapter to connect to your wireless 
network, or restore WZC. Refer to the documentation of your wireless product and the microsoft knowledge 
database on www.microsoft.com for more information.
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How to Establish a Wireless Connection using the WZC
Proceed as follows to start and use the WZC service: 

1 Open the Wireless Network Connection window (see above)

2 From the list, double-click the network you wish to connect to, or select it and click Connect.

Result: The WZC may prompt you for an SSID and a WPA or WEP Key (in case of a secure network):  

3 If applicable, fill in the SSID and the key and click Connect.

Result: a wireless connection to your Thomson Gateway will be established. When the connection is 
ready, Windows informs you through a popup balloon in the notification area: 

i The typical SSID is SpeedtouchXXXXXX where XXXXXXrepresents a set of alphanumerical 
characters. You can find the SSID and the key on the label on the bottom of the Thomson 
Gateway.

i For more detailed information about starting and using the WZC service, visit the Microsoft 
knowledge base on http://support.microsoft.com.
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4.6 Easy Setup Troubleshooting

Prerequisites
Before you run the Easy Setup on the embedded Thomson Gateway pages, make sure that:

> The necessary connections are made.

> The Thomson Gateway is turned on.

> Your host computer is configured as DHCP client or with a valid fixed IP address.

Supported Web browsers
Your Web browser must be able to run JavaScript.

Disable proxy server
The Easy Setup only works if the proxy server is disabled or bypassed for local addresses. For more 
information, refer to the Help of your Web browser.

Proceed as follows to disable a proxy server in Internet Explorer:

1 In the Internet Explorer menu, choose Tools > Internet Options.

2 Click the Connections tab.

3 Click the LAN settings... button. 

4 Clear the Use proxy server box and the Use automatic script box. 

i If you have any problems, you can give the host computer a fixed IP address in the same subnet as 
your Thomson Gateway (If the Thomson Gateway is in its default settings, that is an address 
between 192.168.1.1 and 192.168.1.253).

If you use fixed IP addresses, the Thomson Gateway has to be configured as DNS server (default).

! It is recommended to disable all other network connections on your computer first, except the one 
connecting to your Thomson Gateway.

Proceed as follows to disable a network connection:

1 In the Windows XP taskbar, click the Start button.

2 Choose (All) Programs > Control Panel > (Network and Internet Connections >) Network 

Connections.

3 Right-click the network interface icon you want to disable and choose Disable.
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4.7 Reset to Factory Defaults

Resetting your Thomson Gateway
You might consider a reset to factory defaults as described below.

A reset to factory default settings deletes the configuration profile settings. Therefore, after the reset, a 
reconfiguration of your Thomson Gateway will be needed.

Reset to default configuration
Proceed as follows:

1 Make sure the Thomson Gateway is turned on.

2 Use a pen or an unfolded paperclip to push the recessed reset button on the back panel. The reset button 
is marked with a red circle. Push it until the power LED lights red - this will take about 7 seconds.

3 Release the reset button.

4 The Thomson Gateway restarts.

! Be aware that a reset to factory defaults will revoke all configurational changes you made to the 
Thomson Gateway.

Ethernet

1 432

DSLReset

1

2

4

3

ON/OFF
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